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1 Get started
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Printer parts

1 Paper-width guide

2 Input tray

3 Input tray shield

4 Scanner lid

5 Scanner glass

6 Printhead access door

7 Front door

8 Ink tank

9 Ink tank cap

10 Output tray

11 Output tray extender (also referred to as the tray extender)

12 Control panel
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13 Printheads

14 Printhead latch

15 USB port

16 Power connection
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Get to know the ink tank system

Term Definition

Printheads The printheads are the components in the print mechanism that apply ink to the paper. There are two 
printheads: a black ink printhead and a color ink printhead.

CAUTION: After you have set up the printer, do not open the printhead latch unless instructed to do so.

Printhead latch The printhead latch on the carriage secures the printheads in the carriage. Make sure the printhead latch is 
properly closed to avoid problems such as carriage jams.

CAUTION: After you have set up the printer, do not open the printhead latch unless instructed to do so.

Ink tanks There are four ink tanks. Each ink tank corresponds to an individual color: cyan, magenta, yellow and, 
black.

Ink tank caps Ink tank caps are plugs that seal each ink tank.

Alignment Alignment is a process of aligning the printheads to improve print quality.

For more information about alignment, see Printhead Alignment icon on page 8.

4 Chapter 1   Get started ENWW



Control panel features

Overview of buttons and lights

Feature Description

1 Cancel button: Stops the current operation.

2 Resume button: Resumes a job after a disruption (for example, after loading paper or clearing a paper jam).

Resume light: Indicates the printer is in a warning or error state. Press  to continue printing after 
resolving the problem.

3 Color Copy button: Starts a color copy job. To increase the number counter, press and hold the button. 
Copying starts two seconds after the last button press.

4 Black Copy button: Starts a black-and-white copy job. To increase the number counter, press and hold the 
button. Copying starts two seconds after the last button press.

5 Ink/Printhead light: Indicates ink tank or printhead problems.

6 Color Printhead icon and Black Printhead icon.

7 Control Panel Display: Indicates number counter, paper status, as well as printheads and ink status or 
errors.

8 Information button: Press this button to print an information page of the printer.

9 Power button: Turns the printer on or off.

Control panel display icons

Icon Description

Number Counter icon: Shows the number counter when you are copying documents, changes to the 
letter A when the printer is doing printhead alignment, and shows the letter E and a number when the 
printer is in an error state.

Paper Error icon: Indicates a paper-related error.

Alert icon: Indicates an error.
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Icon Description

The CMYK icons and Ink icons are used to indicate status of the four ink tanks in the printer.

Each set of icons corresponds to an ink tank: cyan, magenta, yellow and, black.

Printhead icons: The left printhead icon flashing shows an error related to the tri-color printhead, and 
the right icon flashing shows an error related to the black printhead.
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Control panel lights and display icons status

Power button light

Status Description

On The printer is on.

Off The printer is powered off.

Dimmed Indicates the printer is in Sleep mode.

● The printer automatically enters Sleep mode after 5 minutes of inactivity.

● The printer automatically turns off after 2 hours of inactivity, if it is not connected to other 
devices.

Blinking The printer is processing a job. To cancel the job, press  (the Cancel button).

Fast blinking If the printhead access door is open, close it. If the printhead access door is closed and the light is 
blinking fast, the printer is in an error state that you can resolve by following the on-screen 
messages from the computer. If you do not see any on-screen messages, try printing a document to 
generate an on-screen message.

Printhead icons and Ink/Printhead light

● The Alert icon, one of the Printhead icons, and the Ink/Printhead light are blinking.

Cause Solution

One of the following might have occurred.

– The corresponding printhead is missing.

– The corresponding printhead is installed incorrectly.

– The corresponding printhead still has an orange plug or 
plastic tape on it.

– The corresponding printhead is incompatible or 
damaged.

– Make sure both printheads are properly installed.

– Install any missing printhead.

– If both printheads are installed, remove the printhead 
indicated, make sure there is no orange plug or plastic 
tape on it, and then reinsert the printhead securely.

– Make sure that you are using the correct HP printheads 
for your printer.

NOTE: For more information, see Printhead (cartridge) 
problem on page 76.

NOTE: Do not open the printhead latch unless 
instructed to do so.

● The Alert icon, both Printhead icons, and the Ink/Printhead light are blinking.
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Cause Solution

One of the following might have occurred.

– One or both printheads are missing.

– One or both printheads are installed incorrectly.

– One or both printheads still have an orange plug or 
plastic tape on them.

– One or both printheads are incompatible or damaged.

– Make sure both printheads are properly installed.

– Install any missing printheads.

– If both printheads are installed, remove the printheads, 
make sure there is no orange plug or plastic tape on 
them, and then reinsert the printheads securely.

– Make sure that you are using the correct HP printheads 
for your printer.

NOTE: For more information, see Printhead (cartridge) 
problem on page 76.

NOTE: Do not open the printhead latch unless 
instructed to do so.

Printhead Alignment icon

Alignment status icon

● The Number Counter icon shows an A or a blinking A.

Cause Solution

The printer is doing printhead alignment.

A blinking "A" appears when the alignment page is being 
printed or scanned.

It stops blinking after the page is printed or scanned.

"A" disappears after the scan when printhead alignment is 
complete.

Once the alignment page is printed, place the printed page 
print-side down on the scanner glass, and then press one of 
the copy buttons on the control panel to scan the page.

Printhead alignment is complete after the scan.

NOTE: To learn how to load an original, see Load original 
on page 40.

● The Number Counter icon shows a blinking A. The Alert icon, Resume light, and Power light are blinking.
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Cause Solution

Printhead alignment failed. This occurs after you have 
scanned the alignment page.

Try one of the following:

– Press  (the Resume button) to reprint the alignment 
page.

– Press one of the copy buttons to rescan the alignment 
page.

If you do not do anything, printhead alignment gets canceled 
after some time.

Alert icon, Paper Error icon, and Resume light

● The Alert icon, the Paper Error icon, and the Resume light are on.

Cause Solution

There is no paper in the input tray. Load paper in the input tray.

For information about how to load paper, see Load media 
on page 21.

● The Alert icon, the Paper Error icon, and the Resume light are blinking.

Cause Solution

The printer receives a printing job, and detects that there is no 
paper in the input tray.

Load paper, and then press  (the Resume button) to 
continue printing.

Number Counter icon

● The Number Counter icon is showing E3. The Alert icon, the Ink/Printhead light, and the Resume light are 
blinking.
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Cause Solution

The carriage inside the printer has stalled. 1. Open the front door, then the printhead access door.

2. Make sure the printhead latch is properly closed and the 
print carriage is not obstructed. Do not open the 
printhead latch.

3. Remove any jammed paper or other objects blocking the 
carriage.

4. Close printhead access door and the front door.

5. Press  (the Resume button) to continue printing or 

press  (the Cancel button). See Jams and paper-feed 

issues on page 68 for more information.

● The Number Counter icon is showing E4. The Alert icon, and the Resume light are blinking.

Cause Solution

There is a paper jam. Clear the jam, and then press  (the Resume button) to 
continue printing.

For more information, see Jams and paper-feed issues 
on page 68.

CAUTION: Do not open the printhead latch.

● The Number Counter icon is showing E5.

Cause Solution

The scanner is not working. Turn the printer off, and then on again.

If the problem persists, contact HP. The printer still prints even 
if the scanner is not working.

● The Number Counter icon is showing E6.
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Cause Solution

The printer is in an error state. Reset the printer.

1. Turn off the printer.

2. Unplug the power cord.

3. Wait a minute, and then plug the power cord back in.

4. Turn on the printer.

If the problem persists, contact HP.

Ink icon, CMYK icon, and Ink/Printhead light

● The CMYK icons are on, and one or more Ink icons are blinking.

Cause Solution

Ink tank is low on ink. Refill the indicated ink tank that is low on ink.

● The CMYK icons are on, and one or more Ink icons are blinking. The Ink/Printhead light is on.

Cause Solution

Ink tank is very low on ink. Refill the indicated ink tank that is very low on ink.

● The Number Counter icon shows E7. The CMYK icons are on. The Ink/Printhead light, one or more Ink 
icons, and the Alert icon are blinking.

Cause Solution

Ink tank is out of ink. Refill the indicated ink tank that is out of ink.
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Change the paper settings
To change the settings from the printer driver

1. Windows 10: From the Windows Start menu, select Windows System, and then click Control Panel. 
Under Hardware and Sound, click View Devices and Printers.

Windows 7: From the Windows Start menu, click Devices and Printers.

2. Right-click the printer icon, and then select Printing Preferences.

3. Click the Paper/Quality tab.

4. From the Media drop-down list, select the appropriate paper type.

5. Click the Advanced button. Then select the appropriate paper size from the Paper Size drop-down list.
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Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15 
cm), 5 x 7 inches (13 x 18 cm), and in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, 
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers 
exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 
inches, and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

● HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo Paper to 
save you time and take the guesswork out of printing affordable, lab-quality photos with your HP 
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printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your 
photos are long lasting and vivid, print after print. Great for printing out an entire vacation's worth of 
photos or multiple prints to share.

Business documents

● HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavyweight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matte

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer 
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.

● HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies

The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, 
and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. 
Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.
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Open the HP printer software
You can use the HP printer software to configure the printer settings, check estimated ink levels, order 
printing supplies, maintain the printer, resolve printing issues, and more. More information about the 
available printer software options is provided throughout this guide.

After completing the hardware setup, visit 123.hp.com on your computer, if you have not installed the HP 
printer software.

NOTE:

● If you are using the HP Smart app instead of the printer software, see Use the HP Smart app to print, 
scan, and troubleshoot on page 16.

● Each device must have the app or software installed in order to print.

● The HP printer software is supported on Windows 7, Windows 10, and macOS 10.12 to 10.14 devices.

After installing the HP printer software, do one of the following:

● Windows 10: From the computer desktop, click Start, select HP from the app list, and then select the 
icon with the printer name.

● Windows 7: From the computer desktop, click Start, select All Programs, click HP, click the folder for 
the printer, and then select the icon with the printer name.

● Mac: From the Applications folder, open the HP folder, and then double-click HP Utility.

ENWW Open the HP printer software 15

http://123.hp.com


Use the HP Smart app to print, scan, and troubleshoot
HP Smart helps you to set up, scan, print, share, and manage your HP printer. You can share documents and 
images through email, text messages, and popular cloud and social media services (such as iCloud, Google 
Drive, Dropbox, and Facebook). You can also set up new HP printers, as well as monitor and order supplies.

NOTE: The HP Smart app is supported on Windows 10 for the printer. The app might not be available in all 
languages. Some features might not be available with all printer models.

● For basic instructions on how to print, scan, and troubleshoot using HP Smart, see Print using the HP 
Smart app (Windows 10) on page 30, Scan using the HP Smart app (Windows 10) on page 41, and Get 
help from the HP Smart app on page 67. For more information, you can also visit www.hp.com/go/
hpsmartwin-help.

To install the HP Smart app on Windows 10 and connect to your printer

1. To get the HP Smart app, visit 123.hp.com or the device app store to download and install the app.

2. After installation, click Start from the computer desktop.

3. To connect to your printer make sure your printer and device are turned on and connected.

4. Open the HP Smart app on your device.

5. On the Home screen of HP Smart, click  (Plus icon), and then select or add a printer.

Follow the onscreen instructions to complete the connection.
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Sleep mode
● Power usage is reduced while in Sleep mode.

● After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.

● The Power button light is dimmed and the printer control panel display is off in Sleep mode.

● Pressing any button on the control panel, or sending a print or scan job can wake up the printer from 
sleep mode.
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Quiet Mode
Quiet Mode slows down printing to reduce overall noise without affecting print quality. Quiet Mode only works 
for printing with Normal print quality on plain paper. To reduce printing noise, turn on Quiet Mode. To print at 
normal speed, turn Quiet Mode off. Quiet Mode is off by default.

NOTE: In Quiet Mode, if you print on plain paper with the Draft or Best print quality, or if you print photos or 
envelopes, the printer works in the same way as when Quiet Mode is off.

To turn Quiet Mode on or off from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software on page 15.

2. Click the Quiet Mode tab.

NOTE: The Quiet mode tab is available only if the printer is connected from the HP printer software.

3. Click On or Off.

4. Click Save Setting.

To turn Quiet Mode on or off from the printer software (macOS)

1. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

2. Select the printer.

3. Click Quiet Mode .

4. Select On or Off .

5. Click Apply Now.
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Auto-Off
This feature turns the printer off after 2 hours of inactivity to help reduce energy use. Auto-Off turns the 
printer off completely, so you must use the Power button to turn the printer back on.

If your printer supports this energy saving feature, Auto-Off is automatically enabled or disabled depending 
on printer capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode 
after 5 minutes of inactivity to help reduce energy use.

● Auto-Off is enabled when the printer is turned on, if the printer does not have network, fax or Wi-Fi 
Direct capability, or is not using these capabilities.

● Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer 
with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.

TIP: To conserve battery power, you can enable Auto-Off, even when the printer is connected or 
wireless is turned on.
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2 Print

● Load media

● Print documents

● Print photos

● Print envelopes

● Print using the HP Smart app (Windows 10)

● Print using the maximum dpi

● Tips for print success

● View print job status and manage print jobs (Windows)

● Customize your printer (Windows)
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Load media
To load paper

1. Raise the input tray.

2. Slide the paper-width guide to the left.

3. Insert a stack of paper into the input tray with the short edge down and the print-side up, and slide the 
stack of paper down until it stops.

If you are loading small-size paper (like photo paper), make sure the paper stack is aligned with the far-
right side of the tray.
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4. Slide the paper-width guide to the right until it stops at the edge of the paper.

5. Pull out the output tray and the tray extender.

To load envelopes

1. Raise the input tray.
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2. Slide the paper-width guide to the left.

3. Insert one or more envelopes into the far-right side of the input tray and slide the stack of envelopes 
down until it stops.

The side to be printed on should face up.

a. For envelope with flap on the long edge, insert the envelope vertically with the flap on the left side 
and facing down.

b. For envelope with the flap on the short edge, insert the envelope vertically with the flap on the top 
and facing down.
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4. Slide the paper-width guide to the right against the stack of envelopes until it stops.

5. Pull out the output tray and the tray extender.
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Print documents
Before printing documents, make sure you have paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 21.

To print a document (Windows)

1. From the File menu in your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options on the Printing Shortcuts or Printing Shortcut tab.

To change other print settings, click the other tabs.

To learn more about the options in the printer driver, hover your mouse over each option to view the 
tooltips.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print documents (macOS)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size, ensure that you have loaded the correct paper.

● Select the orientation.

● Enter the scaling percentage.

4. Click Print.

To print on both sides of the page (Windows)

1. From the File menu in your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.
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4. On the Printing Shortcuts or Printing Shortcut tab, select the Two-sided (Duplex) Printing shortcut, 
and then select an option from the Print On Both Sides Manually drop-down list.

To change other print settings, click the other tabs.

To learn more about the options in the printer driver, hover your mouse over each option to view the 
tooltips.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print on both sides of the page (macOS)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Paper Handling from the pop-up menu and set Page Order to Normal.

3. Set Pages to Print to Odd Only.

4. Click Print.

5. After all of the odd numbered pages have printed, remove the document from the output tray.

6. Reload the document so that the end that came out of the printer is now going into the printer and the 
blank side of the document is facing toward the front of the printer.

7. In the Print dialog, return to the Paper Handling pop-up menu and set the page order to Normal and the 
pages to print to Even Only.

8. Click Print.
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Print photos
Before printing photos, make sure you have photo paper loaded in the input tray and the output tray is open. 
For more information about loading paper, see Load media on page 21.

To print a photo on photo paper (Windows)

1. From the File menu in your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options on the Printing Shortcuts or Printing Shortcut tab.

To change other print settings, click the other tabs.

To learn more about the options in the printer driver, hover your mouse over each option to view the 
tooltips.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

NOTE:  After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout. 

To print a photo from the computer (macOS)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Select the option that provides the best quality or maximum dpi.

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix option.
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– Off: applies no changes to the image.

– On: automatically focuses the image; moderately adjusts image sharpness.

5. Select any other print settings you want, and then click Print.
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Print envelopes
Before printing envelopes, make sure you have envelopes loaded in the input tray and the output tray is open. 
You can load one or more envelopes into the input tray. Do not use shiny or embossed envelopes or envelopes 
that have clasps or windows. For more information about loading envelopes, see Load media on page 21.

NOTE: For details on how to format text for printing on envelopes, refer to the documentation of the 
application that you are using.

To print an envelope (Windows)

1. From the File menu in your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options on the Printing Shortcuts or Printing Shortcut tab.

To change other print settings, click the other tabs.

To learn more about the options in the printer driver, hover your mouse over each option to view the 
tooltips.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print envelopes (macOS)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Select the appropriate envelope size from the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

NOTE: If you change the paper size, ensure that you have loaded the correct paper.

4. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to Plain 
Paper.

5. Click Print.
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Print using the HP Smart app (Windows 10)
This section provides basic instructions for using the HP Smart app to print from your device. For more 
information about the app, see Use the HP Smart app to print, scan, and troubleshoot on page 16.

To begin using the HP Smart app to print

1. Load paper in the input tray. For more information, see Load media on page 21.

2. Open the HP Smart app on your device.

3. On the Home screen of HP Smart, make sure your printer is selected.

TIP: If a printer is already set up, you can select it from the Home screen of HP Smart by swiping left or 
right and selecting it.

To use a different printer, click or tap (Plus icon) on the Home screen, and then select a different 
printer or add a new printer.

To print from a Windows 10 device

1. On the Home screen of HP Smart, do one of the following:

● Select Print Photo, locate a photo you want to print, and then click or tap Select Photos to Print.

● Select Print Document, locate a PDF document you want to print, and then click or tap Print.

2. Select the appropriate options. To view more settings, click or tap More settings.

For more information about printing settings, see Tips for print success on page 33.

3. Click or tap Print to begin printing.

30 Chapter 2   Print ENWW



Print using the maximum dpi
Use maximum dots per inch (dpi) to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk 
space.

For supported print resolutions, visit the printer support website at www.support.hp.com.

To print in maximum dpi mode (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

Windows 10

● Click the Paper/Quality tab. From the Paper Size drop-down list, select the appropriate paper size. 
From the Paper Type drop-down list, select the appropriate paper type.

● Click the Advanced tab, and then select Print in Max DPI.

Windows 7

● Click the Paper/Quality tab. From the Media drop-down list, select the appropriate paper type.

● Click the Advanced button. Select the appropriate paper size from the Paper Size drop-down list. 
In the Printer Features area, select Yes from the Print in Max DPI drop-down list. Then click OK to 
close the Advanced Options dialog.

For more printing tips, see Printer settings tips on page 33.

5. Confirm the orientation on the Layout tab, and then click OK to print.

To print using maximum dpi (macOS)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:
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● Paper Type: The appropriate paper type

● Quality: Maximum dpi

5. Select any other print settings that you want, and then click Print.
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Tips for print success
● Paper loading tips

● Printer settings tips 

To print successfully, the HP printheads should be functioning properly, the ink tanks should be filled with 
sufficient ink, the paper should be loaded correctly, and the printer should have the appropriate settings. For 
more information, see Tips for working with ink and printhead on page 59.

Print settings do not apply to copying or scanning.

Paper loading tips

● Load a stack of paper (not just one page). All of the paper in the stack should be in the same size and 
type to avoid a paper jam.

● Load the paper with side to be printed on facing up.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.

For more information, see Load media on page 21.

Printer settings tips

Printer settings tips (Windows)

● To change default print settings, open the HP printer software, click Print & Scan , and then click Set 
Preferences. For information how to open the printer software, see Open the HP printer software 
on page 15.

TIP: To learn more about the options in the printer driver, hover your mouse over each option to view 
the tooltips.

● You can use printing shortcuts to save time setting desired printing preferences. A printing shortcut 
stores the settings that are appropriate for a particular type of job, so that you can set all the options 
with a single click. To use a shortcut, go to the Printing Shortcuts or Printing Shortcut tab, select the 
desired shortcut, and then click OK.

To add a new printing shortcut, set the desired printing preferences on the Paper/Quality, Layout, or 
Advanced tab, select the Printing Shortcuts or Printing Shortcut tab, click Save As and enter a name, 
and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

● To understand paper and paper tray settings:

– Paper Size: Select the paper size you loaded in the input tray.

– Paper Source: Select the paper tray you loaded the paper into.

– Paper Type or Media: Select the paper type you are using.
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● To understand color or black and white settings:

– Color: Uses black and color ink for full color prints.

– Black & White or Black Ink Only: Uses the black ink only for normal or lower quality black and 
white prints.

– High Quality Grayscale: Uses black and color ink to produce a wider range of black and grey tones 
for high quality black and white prints.

● To understand print quality settings:

The print quality is measured in print resolution dots per inch (dpi). Higher dpi produces clearer and 
more detailed prints, but slows print speed and might use more ink.

– Draft: Lowest dpi typically used when ink levels are low or when high quality prints are not needed.

– Normal: Suitable for most print jobs.

– Best: Better dpi than Normal.

– Print in Max DPI: Highest dpi setting available for print quality.

– HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved 
print quality.

● To understand page and layout settings:

– Orientation: Select Portrait for vertical prints or Landscape for horizontal prints.

– Print on Both Sides Manually: Manually flip the pages after one side of the paper prints out so that 
you can print on both sides of the paper.

○ Flip on Long Edge: Select it if you want to flip pages by the long edge of the paper when 
printing on both sides of the paper.

○ Flip on Short Edge: Select it if you want to flip pages by the short edge of the paper when 
printing on both sides of the paper.

– Booklet Layout or Booklet: Allows you to print a multiple-page document as a booklet. It places 
two pages on each side of a sheet that can then be folded into a booklet in half size of the paper.

○ Left binding or Booklet-LeftBinding: The binding side after folded into a booklet appears at 
the left side. Select this option if your reading habit is from left to right.

○ Right binding or Booklet-RightBinding: The binding side after folded into a booklet appears 
at the right side. Select this option if your reading habit is from right to left.

– Borderless or Page Borders: Allows you to add or remove borders to the pages if you print the 
document with two or more pages per sheet.

– Pages per Sheet Layout: Helps you specify the order of the pages if you print the document with 
more than two pages per sheet.

– Pages to Print: Allows you to print the odd pages only, print the even pages only, or print all pages.

– Reverse page order or Page Order: Allows you to print pages from front to back or in reverse 
order.
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Printer settings tips (macOS)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type 
and quality.

● To print a black and white document using only black ink, choose the Paper Type/Quality from the pop-
up menu and choose Grayscale from the Color pop-up menu.
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View print job status and manage print jobs (Windows)
To view, pause, or cancel your print jobs, open the HP printer software (available from the Start menu), click 
Print & Scan , and then click See What’s Printing.
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Customize your printer (Windows)
To change the printer name, security settings, or other properties, open the HP printer software (available 
from the Start menu), click Print & Scan , and then click Customize Your Printer.
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3 Copy and scan

● Copy documents

● Load original

● Scan using the HP Smart app (Windows 10)

● Scan using the HP printer software

● Tips for successful scanning and copying
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Copy documents
NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality 
when copying.

For information on HP Smart app, see Use the HP Smart app to print, scan, and troubleshoot on page 16.

To copy documents

1. Load paper in the input tray.

For information about how to load paper, see Load media on page 21.

2. Load the original print-side down near the icon at the corner of the scanner glass.

For more information, see Load original on page 40.

3. Press either  (the Black Copy button) or  (the Color Copy button) to make a copy.

Copying will start two seconds after the last button press.

TIP: You can increase the number counter by pressing, and holding a copy button.

To change the paper settings when copying

Current paper 
type Do this

To change to 
this paper type

Printer display 
shows this icon

Plain paper Press and hold both copy buttons (  ) at the same time for three 
seconds.

Photo paper

Photo paper Press and hold both copy buttons (  ) at the same time for three 
seconds.

Plain paper
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Load original
To load an original on the scanner glass

1. Lift the scanner lid.

2. Load the original print-side down near the icon at the corner of the scanner glass.

3. Close the scanner lid.
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Scan using the HP Smart app (Windows 10)
This section provides basic instructions for using the HP Smart app to scan from your device. For more 
information about the app, see Use the HP Smart app to print, scan, and troubleshoot on page 16.

Scan from a Windows 10 device

To scan a document or photo using the printer scanner

1. Load the original print-side down near the icon at the corner of the scanner glass on the printer.

2. Open HP Smart. For more information, see Use the HP Smart app to print, scan, and troubleshoot 
on page 16.

3. Select Scan, and then select Scanner.

4. Click or tap the Settings icon to modify the basic settings.

Select Glass from the Source drop-down list.

5. Click or tap the Preview icon to preview and adjust the image if necessary.

6. Click or tap the Scan icon.

7. Make other adjustments if necessary:

● Click or tap Add Pages to add more documents or photos.

● Click or tap Edit to rotate or crop the document or image, or adjust its contrast, brightness, 
saturation, or angle.

8. Select the file type you want, and then click or tap the Save icon to save it or click or tap the Share icon 
to share it with others.

To scan a document or photo using the device camera

If your device has a camera, you can use the HP Smart app to scan a printed document or photo with the 
device camera. You can then use HP Smart to edit, save, print or share the image.

1. Open HP Smart. For more information, see Use the HP Smart app to print, scan, and troubleshoot 
on page 16.

2. Select Scan, and then select Camera.

3. Put a document or photo in front of the camera, and then click or tap the round button at the bottom of 
the screen to take an image.

4. Adjust boundaries if needed. Click or tap the Apply icon.

5. Make other adjustments if necessary:

● Click or tap Add Pages to add more documents or photos.

● Click or tap Edit to rotate or crop the document or image, or adjust its contrast, brightness, 
saturation, or angle.

6. Select the file type you want, and then click or tap the Save icon to save it or click or tap the Share icon 
to share it with others.
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To edit a previously scanned document or photo

HP Smart provides editing tools, such as crop and rotate, which you can use to adjust a previously scanned 
document or photo on your device.

1. Open HP Smart. For more information, see Use the HP Smart app to print, scan, and troubleshoot 
on page 16.

2. Select Scan, and then select Import.

3. Select the document or photo that you want to adjust, and then click or tap Open.

4. Adjust boundaries if needed. Click or tap the Apply icon.

5. Make other adjustments if necessary:

● Click or tap Add Pages to add more documents or photos.

● Click or tap Edit to rotate or crop the document or image, or adjust its contrast, brightness, 
saturation, or angle.

6. Select the file type you want, and then click or tap Save or Share to save the file or share it with others.
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Scan using the HP printer software
● Scan from a computer

● Change scan settings (Windows)

● Create a new scan shortcut (Windows)

Scan from a computer

Before scanning from a computer, make sure you have already installed the HP recommended printer 
software. The printer and computer must be connected and turned on.

To scan a document or photo to a file (Windows)

1. Load the original print-side down near the icon at the corner of the scanner glass.

2. In the HP printer software (available from the Start menu), click Scan , and then click Scan a Document 
or Photo .

3. Select the type of scan you want and then click Scan .

● Choose Save as PDF to save the document (or photo) as a PDF file.

● Choose Save as JPEG to save the photo (or document) as an image file.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 44.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview 
screen.

To scan a document or photo to email (Windows)

1. Load the original print-side down near the icon at the corner of the scanner glass.

2. In the HP printer software, available from the Start menu, click Scan , and then click Scan a Document 
or Photo .

3. Select the type of scan you want and then click Scan .

Choose Email as PDF or Email as JPEG to open your email software with the scanned file as an 
attachment.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 44.

If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the preview 
screen.
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To scan an original from HP printer software (macOS)

1. Open HP Easy Scan.

HP Easy Scan is located in the Applications folder.

2. Choose the type of scan profile you want.

3. Click Scan.

Change scan settings (Windows)

You can modify any of the scan settings either for a singular use or save the changes to use permanently. 
These settings include options such as page size and orientation, scan resolution, contrast, and the folder 
location for saved scans.

1. Load the original print-side down near the icon at the corner of the scanner glass.

2. In the HP printer software, available from the Start menu, click Scan , and then click Scan a Document 
or Photo .

3. Click the More link in the top right corner of the HP Scan dialog.

The detailed settings pane appears on the right. The left column summarizes the current settings for 
each section. The right column allows you to change the settings in the highlighted section.

4. Click each section at the left of the detailed settings pane to review the settings in that section.

You can review and change most settings using drop-down menus.

Some settings allow greater flexibility by displaying a new pane. These are indicated by a + (plus sign) at 
the right of the setting. You must either click OK to accept or click Cancel to cancel any changes on this 
pane to return to the detailed settings pane.

5. When you have finished changing settings, do one of the following:

● Click Scan . You are prompted to save or reject the changes to the shortcut after the scan is 
finished.

● Click the save icon to the right of the shortcut, and then click Scan .

Create a new scan shortcut (Windows)

You can create your own scan shortcut to make scanning easier. For example, you might want to regularly 
scan and save photos in PNG format, rather than JPEG.

1. Load the original print-side down near the icon at the corner of the scanner glass.

2. In the HP printer software, available from the Start menu, click Scan , and then click Scan a Document 
or Photo .

3. Click Create New Scan Shortcut .
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4. Enter a descriptive name, choose an existing shortcut on which to base your new shortcut, and then click 
Create .

For example, if you are creating a new shortcut for photos, choose either Save as JPEG or Email as 
JPEG . This makes available the options for working with graphics when scanning.

5. Change the settings for your new shortcut to meet your needs, and then click the save icon to the right 
of the shortcut.

NOTE: Click the More link at the top right corner of the Scan dialog to review and modify settings for 
any scan.

For more information, see Change scan settings (Windows) on page 44.
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Tips for successful scanning and copying
Use the following tips to copy and scan successfully:

● Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as 
part of the image.

● Load the original print-side down near the icon at the corner of the scanner glass.

● To make a large copy of a small original, scan the original into the computer, resize the image in the 
scanning software, and then print a copy of the enlarged image.

● To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the 
software.
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4 Manage ink and printhead

This section contains the following topics:

● Ink levels

● Refill ink tanks

● Order ink supplies

● Print with black ink only

● Improve print quality

● Align printheads

● Clean printheads

● Clean printer

● Tips for working with ink and printhead

● Move printer 
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Ink levels
You can check the ink levels from the ink tanks on the printer. You can also check the HP printer software to 
determine when the tanks need to be refilled.

To check the ink levels from the printer software (Windows)

1. In the HP printer software (available from the Start menu), click Estimated Levels at the top of the 
window.

2. In the Toolbox, click the Estimated Levels tab.

To check the ink levels from the HP printer software (macOS)

1. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

2. Select the printer from the list of devices at the left of the window.

3. Click Supplies Status.

The estimated ink levels appear.

4. Click All Settings to return to the Information and Support pane.
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Refill ink tanks
NOTE: Product service or repairs required as a result of filling the ink tanks improperly and/or using non-HP 
ink will not be covered under warranty.

To refill the ink tanks

1. Open the front door.

2. Open the cap of the ink tank you plan to refill.

3. Depending on the type of ink bottles you have, do one of following:

● Screw-cap bottles: Twist to remove the cap of the ink bottle.
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● Flip-cap bottles: Twist to remove the cap of the ink bottle, remove the seal from the bottle, install 
the cap back onto the bottle, and then pull open the top part of the cap.

4. Match the color of the ink bottle with the color of the ink tank. Hold the bottle on the tank nozzle, 
making sure the tip of the bottle fits properly over the nozzle, and let the ink drain into the tank until the 
tank is full. If the ink does not drain immediately, remove the bottle and properly reinsert it on the tank.

NOTE: Do not squeeze the ink bottles when filling ink. The ink bottles you have might vary.

Screw-cap bottles Flip-cap bottles

NOTE: If there is leftover ink in the bottle, store the bottle in an upright position in a cool and dry 
location.
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5. Close the ink tank cap securely.

6. Repeat steps 2 to 5 to refill other ink tanks.

7. Close the front door of the printer.

Precautions for working with ink bottles

Use the following tips to work with ink bottles:

● Keep the ink bottles beyond the reach of children.

● Open the ink bottles only when you plan to fill the ink tanks.

● Do not tilt, shake, or squeeze the ink bottle when it is open to prevent ink leaks.

● Store the ink bottles in a cool, dark place.

● Do not drink or place in mouth.
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Order ink supplies
Before ordering ink bottles, visually check the labels on the ink bottles to locate the ink bottle numbers. You 
can also find this information on the product label located on the inside of the front door.

To order original HP supplies for the printer, go to www.hp.com/buy/supplies . If prompted, choose your 
country/region, and then follow the prompts to find the right ink bottles for your printer.

NOTE: Ordering ink bottles online is not supported in all countries/regions. If it is not available in your 
country/region, you may still view supplies information and print a list for reference when shopping at a local 
HP reseller.
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Print with black ink only
To print with black ink only(Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

Windows 10

● Click Paper/Quality tab.

● Under Print in Grayscale, select Black Ink Only from the list, and then click OK.

Windows 7

● On the Layout or Paper/Quality tab, click the Advanced button to open the Advanced Options 
dialog box.

● From the Print in Grayscale drop-down list, select Black Ink Only, and then click OK.

To print with black ink only (macOS)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: Locations for the options can vary from one application to another. 

4. From the pop-up menu, choose Paper Type/Quality.

5. From the Color pop-up menu, choose Grayscale, and then click Print.
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Improve print quality
You can print a diagnostics page to determine if cleaning or aligning the printheads is recommended to 
improve print quality.

From the HP Smart app, you can also improve the print quality. For more information about the app, see Use 
the HP Smart app to print, scan, and troubleshoot on page 16.

To print a print quality diagnostics page from the printer control panel

1. Load Letter or A4 unused plain white paper into the input tray.

2. Press  (the Color Copy button), and  (the Resume button) at the same time.

To print a print quality diagnostics page from the HP printer software

1. Load Letter or A4 unused plain white paper into the input tray.

2. Complete the steps for your operating system:

Windows:

a. In the HP printer software (available from the Start menu), click Print & Scan at the top of the 
window.

b. In the Print section, click Maintain Your Printer to access the Toolbox.

c. In the Toolbox, click the Device Services tab, and then click Print Quality Diagnostics Page.

Mac:

a. In the Applications folder, open the HP folder, and then double-click HP Utility.

b. In the All Settings section, click Print Quality Diagnostics, and then click Print.
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3. Review the cyan, magenta, yellow, and black boxes along with the other content on the diagnostics 
page.

4. Clean the printheads, if the diagnostic page shows steaks or missing portions of the color and black 
boxes.

For more information, see Clean printheads on page 57.

5. Align the printheads, if straight lines appear jagged on printouts, or if the diagnostic page indicates 
aligning printheads might help.

For more information, see Align printheads on page 56.

6. If print quality problems persist after cleaning and aligning printheads, contact HP support.
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Align printheads
Aligning the printheads can improve print quality. If you notice misaligned colors or lines in your printouts or 
on the print quality diagnostics page, you should perform an alignment. For more information about the print 
quality diagnostics page, see Improve print quality on page 54.

To align the printheads (Windows)

1. Load Letter or A4 unused plain white paper into the input tray.

2. In the HP printer software (available from the Start menu), click Print & Scan at the top of the window.

3. In the Print section, click Maintain Your Printer to access the Toolbox.

4. In the Toolbox, click the Device Services tab, click the desired option, and then follow the onscreen 
instructions.

To align the printheads (macOS)

1. Load Letter or A4 plain, white paper in the input tray.

2. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

3. Select your printer from the list of devices at the left of the window.

4. Click Align.

5. Click Align and follow the onscreen instructions.

6. Click All Settings to return to the Information and Support pane.
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Clean printheads
If your prints are streaked or have incorrect or missing colors, the printheads might need to be cleaned. You 
can also check the print quality diagnostics page to determine if cleaning is recommended. The cleaning 
process prints one page to attempt to clean the printheads. For more information about the print quality 
diagnostics page, see Improve print quality on page 54.

NOTE: Clean the printheads only when necessary. Unnecessary cleaning wastes ink and shortens the life of 
the printheads.

To clean the printheads (Windows)

1. Load Letter or A4 unused plain white paper into the input tray.

2. In the HP printer software (available from the Start menu), click Print & Scan at the top of the window.

3. In the Print section, click Maintain Your Printer to access the Toolbox.

4. In the Toolbox, click the Device Services tab, click the desired option, and then follow the onscreen 
instructions.

To clean the printheads (macOS)

CAUTION: Clean the printheads only when necessary. Unnecessary cleaning wastes ink and shortens the life 
of the printheads.

1. Load Letter or A4 plain, white paper in the input tray.

2. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

3. Select your printer from the list of devices at the left of the window.

4. Click Clean Printheads.

5. Click Clean, and follow the onscreen instructions.

CAUTION: Clean the printhead only when necessary. Unnecessary cleaning wastes ink and shortens 
the life of the print head.

NOTE: If print quality still seems poor after you complete cleaning, try aligning the printhead. If print 
quality problems persist after cleaning and aligning, contact HP support.

6. Click All Settings to return to the Information and Support pane.
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Clean printer
You can run a cleaning routine from the printer software to prevent back of page smearing.

To clean the printer from the printer software (Windows)

1. Load Letter or A4 unused plain white paper into the input tray.

2. In the HP printer software (available from the Start menu), click Print & Scan at the top of the window.

3. In the Print section, click Maintain Your Printer to access the Toolbox.

4. In the Toolbox, click the Device Services tab, click the desired option, and then follow the onscreen 
instructions.
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Tips for working with ink and printhead
Printhead tips

Use the following tips to work with printheads:

● Use original HP printheads.

● To protect the printheads from drying out, always turn the printer off using the Power button, and wait 
until the Power button light goes out.

● Do not open or untape printheads until you are ready to install them. Leaving tape on the printheads 
reduces ink evaporation.

● Install both the black and color printheads correctly.

For more information, see Printhead (cartridge) problem on page 76.

● After you have set up the printer, do not open the printhead latch unless instructed to do so.

● Align the printer for best print quality. See Improve print quality on page 54 for more information.

● If you remove a printhead from the printer for any reason, try to replace it again as soon as possible. 
Outside of the printer, if unprotected, the printhead may begin to dry out.

Ink tips

Use the following tips to work with ink:

● Make sure the ink tanks are not low on ink before printing.

For more information, see Ink levels on page 48.

● Refill the ink tanks when they are low on ink. Printing with the ink tanks low on ink may cause damage to 
your printer.

● Do not tilt the printer.

NOTE: Original HP printheads and ink are designed and tested with HP printers and papers to help you easily 
produce great results, time after time.

HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a 
result of using a non-HP supply will not be covered under warranty.
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Move printer
To prevent damage to the printer or ink leakage, follow these instructions.

If you are moving the printer within your home or office, keep the printhead latch closed, and keep the printer 
level.

If you are moving the printer outside your home or office, see the instructions provided inbox for moving 
printer, or visit www.support.hp.com .
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5 Connect

● Connect your printer to your computer with a USB cable (non-network connection)
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Connect your printer to your computer with a USB cable (non-
network connection)

The printer supports a rear USB 2.0 High Speed port for connection to a computer.

If the HP printer software has been installed, the printer will operate as a plug-and-play device. If the 
software has not been installed, follow the steps below to connect the printer with the USB cable.

To connect the printer with a USB cable using the HP printer software

1. Enter 123.hp.com in a web browser on your computer to download and install the HP printer software. 
You can also use the HP printer software CD (if provided), or download the software from 
www.support.hp.com .

NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the onscreen instructions. When you are prompted, connect the printer to the computer by 
selecting USB on the Connection Options screen.

3. Follow the onscreen instructions.

To connect the printer with a USB cable using the HP Smart app

1. Connect the USB cable to the printer from your device.

2. Open the HP Smart app on your device. For information, see Use the HP Smart app to print, scan, and 
troubleshoot on page 16.

3. On the Home screen of HP Smart, click or tap  (Plus icon), and then select your printer.
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6 Solve a problem

This section contains the following topics:

● Get help with HP online troubleshooting

● Get more help

● Printer control panel errors 

● Get help from the HP Smart app

● Jams and paper-feed issues

● Printhead (cartridge) problem

● Printing issues

● Copy issues

● Scan issues

● Printer hardware issues

● Restore original factory defaults and settings

● Maintain the printer

● HP support
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Get help with HP online troubleshooting
Use an HP online troubleshooting tool to solve your printer issues. Use the table below to identify your 
problem and click the appropriate link.

NOTE: The HP online troubleshooting wizards might not be available in all languages.

Online troubleshooting tool Use this tool to learn how to:

Troubleshoot paper jam issues Clear jammed paper from the printer and resolve paper or paper feed issues.

Troubleshoot a print carriage 
jam

Clear obstructions that are blocking the print carriage.

Troubleshoot issues with print 
job not printing

Resolve issues with printer responsiveness, pages not printing, or “Unable to print” errors.

Troubleshoot copy and scan 
issues

Determine why the printer will not copy or scan, or improve the quality of your copies or scans.

Troubleshoot print quality 
issues

Improve the quality of your prints.

HP Print and Scan Doctor

(For Windows operating 
systems only)

Automatically diagnose and resolve printer issues.

HP Virtual Agent Chat with HP Virtual Agent to troubleshoot issues.
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Get more help

Solve printer issues with HP online troubleshooting 
tools

Get help with HP online troubleshooting on page 64

Diagnose and resolve printer issues

HP Print and Scan Doctor

(For Windows operating systems only)

Get printer documentation, troubleshooting 
information, software updates, and more

www.support.hp.com

Use my device to print, scan, and manage my printer 
with the HP Smart app

● Windows: www.hp.com/go/hpsmartwin-help

Scan with HP Scan software

HP Scan software

Order ink supplies

HP Sure Supply

Contact HP support

Contact support website

  

Register my product

www.register.hp.com

View printer warranty options

www.support.hp.com
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Printer control panel errors
If the Number Counter icon on the printer display is alternating between the letter E and a number, it indicates 
the printer is in an error state. The letter E and the number work as error codes. For example, if the Number 
Counter icon is alternating between the letter E and the number 4, it indicates that a paper jam has occurred.

For details on the errors and solutions, see Control panel lights and display icons status on page 7.
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Get help from the HP Smart app
The HP Smart app provides alerts for printer issues (jams and other problems), links to help content, and 
options to contact support for additional assistance. For more information about the app, see Use the HP 
Smart app to print, scan, and troubleshoot on page 16.

1. Open the HP Smart on your device.

2. On the Home screen of HP Smart, make sure your printer is selected.

TIP: If a printer is already set up, you can select it from the Home screen of HP Smart by swiping left or 
right and selecting it.

To use a different printer, click or tap (Plus icon) on the Home screen, and then select a different 
printer or add a new printer.

3. To view the printer status, click or tap the printer icon.
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Jams and paper-feed issues

Clear a paper or print carriage jam

Solve paper jam issues. Use an HP online troubleshooting wizard

Get step-by-step instructions for clearing paper jams and resolving issues with paper or the paper feed.

Resolve a print carriage jam. Use an HP online troubleshooting wizard

If something is blocking the print carriage or it does not move easily, get step-by-step instructions.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing jams

Paper jams can occur in several locations. For print carriage jams, remove any objects, including paper, that 
are blocking the print carriage in the printhead access area.

NOTE: Do not use any tools or other devices to remove jammed objects. Always use caution when removing 
jammed objects from inside the printer.

To clear a paper jam from the input tray

1. Press  (the Cancel button) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.

2. Pull the paper gently out of the input tray.

3. Make sure there is no foreign object in the paper path, and then reload paper.

NOTE: The input tray shield can prevent foreign debris from falling into the paper path and causing 
serious paper jams. Do not take down the input tray shield. 

4. Press  (the Resume button) on the control panel to continue the current job.

To clear a paper jam from the output tray

1. Press  (the Cancel button) to try to clear the jam automatically. If this does not work, complete the 
following steps to clear the jam manually.
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2. Pull the paper gently out of the output tray.

3. Press  (the Resume button) on the control panel to continue the current job.

To clear paper or other objects from the printhead access area

1. Press  (the Cancel button) to cancel printing. If this does not clear the error, complete the following 
steps to clear the jam manually.

2. Close the output tray extender, and then close the output tray.

3. Open the front door of the printer.
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4. Open the printhead access door.

5. Make sure the print carriage is not obstructed. You might need to slide the carriage to the right side.

Remove any jammed paper or other objects blocking the carriage.

6. Make sure the printhead latch is properly closed.

NOTE: After you have set up the printer, do not open the printhead latch unless instructed to do so.

7. Close the front door of the printer.
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8. Pull out the output tray and the tray extender.

To clear a paper jam inside of the printer

NOTE: Follow the instructions in this section after you have tried other ways to clear paper jams. Before you 
begin, make sure the ink tank caps are firmly closed to prevent ink from leaking. 

1. Press  (the Cancel button) to cancel printing. If this does not clear the error, complete the following 
steps to clear the jam manually.

2. Press  (the Power button) to turn off the printer.

3. Open the front door, and then open the printhead access door.

NOTE: If the print carriage is not on the left side, manually move it to far left.
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4. Press down on the side of the printhead latch to open.

NOTE: After you have set up the printer, do not open the printhead latch unless instructed to do so.

5. Close the doors.

6. Lift the front of the printer so that the printer is resting on its rear, to expose the bottom cleanout. 
Locate the cleanout door on the bottom of the printer, and then pull both tabs on the cleanout door to 
open it.

NOTE: Do not keep the printer in a tilted position for too long to prevent ink from leaking. 

7. Remove the jammed paper.
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8. Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

9. Turn the printer upright.

10. Open the front door, and then open the printhead access door.

11. Close the printhead latch, and then close the doors.

12. Connect the power cord, and then turn on the printer.

Learn how to avoid paper jams

To help avoid paper jams, follow these guidelines.

● Do not overfill the input tray, but make sure that you have at least 5 pages loaded, for best results.

● Keep your printer free of dust and debris by removing paper and closing the input tray when not in use.

● Remove printed papers from the output tray frequently.

● Ensure that paper loaded in the input tray lays flat, and the edges are not bent or torn.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

Use HP paper for optimum performance. See Paper basics on page 13 for more information about HP 
paper.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width 
guide does not bend the paper in the input tray.
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● Do not force paper too far down in the input tray.

● Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until the out 
of paper message appears before adding paper.

Solve paper-feed problems

What kind of problem are you having?

● Paper is not picked up from the input tray   

– Make sure paper is loaded in the input tray. For more information, see Load media on page 21.

– Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

– Make sure paper in the input tray is not curled. Uncurl paper by bending it in the opposite direction 
of the curl.

– Clean the paper rollers.

● Pages are skewing   

– Make sure the paper is loaded in the far-right side of the input tray and the paper-width guide is fit 
against the left side of the paper.

– Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

– Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-
width guide does not bend the paper in the input tray.

– Make sure the input tray is not overloaded with paper.

– Make sure the pieces of the loaded paper are not sticking together.

– Use HP paper for optimum performance and efficiency.

– Clean the paper rollers.

To clean the paper rollers manually

1. Gather the following materials:

● A long, lint-free cotton swab

● Distilled, filtered, or bottled water (tap water might damage the printer)

2. Press  (the Power button) to turn off the printer.

3. Disconnect the power cord from the rear of the printer.

4. Disconnect the USB cable, if it is not already disconnected.

5. Raise the input tray.

6. Lift and hold the input tray shield.
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NOTE: Do not remove the input tray shield. The input tray shield prevents foreign debris from falling 
into the paper path and causing paper jams.

7. Look down through the open input tray and find the gray paper pick rollers. You might need a flashlight 
to illuminate the area.

8. Dampen a long cotton swab with bottled or distilled water, and then squeeze any excess water from the 
cloth.

9. Press the swab against the rollers, and then rotate them upward with your fingers. Apply a moderate 
amount of pressure to remove dust or dirt buildup.

10. Lower the input tray shield.

11. Allow the rollers to dry for 10 or 15 minutes.

12. Reconnect the power cord to the rear of the printer.

13. Reconnect the USB cable to the printer if necessary.

14. Press the Power button to turn on the printer.
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Printhead (cartridge) problem
If a message indicates a printhead problem, try the following in order:

1. Verify that the indicated printhead is correctly installed.

2. Clean the printhead contacts.

3. Contact HP support for assistance. Go to www.support.hp.com .

NOTE: For more information on printhead problem, see Printhead icons and Ink/Printhead light 
on page 7.

To verify the printhead installed properly

NOTE: The instructions here are only applicable in this section. After you have set up the printer, do not 
open the printhead latch unless instructed to do so.

1. Make sure the printer is turned on.

2. Close the output tray extender, and then close the output tray.

3. Remove and reinsert the printhead.

a. Open the front door of the printer.
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b. Open the printhead access door.

NOTE: After you have set up the printer, do not open the printhead latch unless instructed to do 
so.

c. Push down to open the printhead latch.

d. Remove the printhead from the carriage.

e. Check if there is a plug on top of the printhead or plastic tape on the printhead contacts. If there is, 
remove the plug from top of the printhead and the plastic tape from contacts.

NOTE: Do not touch the electrical contacts on the printhead.
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f. Slide the printhead into the slot until it clicks into place.

g. Close the printhead latch. Make sure the printhead latch is properly closed to avoid problems such 
as carriage jams.

h. Close the front door of the printer.

4. Pull out the output tray and the tray extender.
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To clean printhead contacts

NOTE:

● Open the printhead latch and clean printhead contacts only when necessary; for example, if a printhead 
cannot be detected.

The instructions here are only applicable in this section. After you have set up the printer, do not open 
the printhead latch unless instructed to do so.

● The cleaning procedure should take only a few minutes. Make sure that the printheads are reinstalled in 
the printer as soon as possible. It is not recommended to leave the printheads outside of the printer 
longer than 30 minutes. This could result in damage to the printheads.

1. Make sure the printer is turned on.

2. Close the output tray extender, and then close the output tray.

3. Open the front door of the printer.
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4. Open the printhead access door.

NOTE: After you have set up the printer, do not open the printhead latch unless instructed to do so.

5. Push down to open the printhead latch.

6. Remove the printhead indicated in the error message.

7. Clean the printhead contacts and printer contacts.

a. Hold the printhead by its sides and locate the electrical contacts on the printhhead.

The electrical contacts are the small gold-colored dots on the printhead.

b. Wipe only the contacts with a dry swab or lint-free cloth.

NOTE: Be careful to wipe only the contacts, do not smear any ink or other debris on the contacts.
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c. On the inside of the printer, locate the contacts for the printhead.

The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the 
printhead.

d. Use a dry swab or lint-free cloth to wipe the contacts.

NOTE: Be careful to wipe only the contacts, do not smear any ink or other debris on the contacts.

8. Reinstall the printhead.

9. Close the printhead latch. Make sure the printhead latch is properly closed to avoid problems such as 
carriage jams.

10. Close the front door of the printer.

11. Check if the error message has gone away. If you still receive the error message, turn the printer off, and 
then on.
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Printing issues

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for the Windows operating system. 

Troubleshoot problems with 
print jobs not printing.

Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer is not responding or printing.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable to print, 
try the following in order:

1. Check for error messages from the printer software and resolve them by following the on-screen 
instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending upon your operating system, do one of the following:

● Windows 10: From the Windows Start menu, select Windows System from the app list, select 
Control Panel, and then click View devices and printers under Hardware and Sound.

● Windows 7: From the Windows Start menu, click Devices and Printers.

b. Either double-click or right-click the icon for your printer and select See what's printing to open 
the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer 
Offline.

d. If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending upon your operating system, do one of the following:
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● Windows 10: From the Windows Start menu, select Windows System from the app list, select 
Control Panel, and then click View devices and printers under Hardware and Sound.

● Windows 7: From the Windows Start menu, click Devices and Printers.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending upon your operating system, do one of the following:

● Windows 10 : From the Windows Start menu, click Windows System, and then click Control 
Panel.

● Windows 7: From the Windows Start menu, click Control Panel.

b. Click System and Security, and then click Administrative Tools.

c. Double-click Services.

d. Right-click the Print Spooler, and then click Properties.

e. On the General tab, make sure Automatic is selected from the Startup type drop-down list.

f. Under Service status, check the status.

● If the service is not running, click Start.

● If the service is running, click Stop, and then click Start to restart the service.

Then click OK.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending upon your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click Windows System, and then click Control 
Panel. Under Hardware and Sound, click View devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

b. Right-click the printer, and then select the option to see what is printing.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to 
confirm.
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d. If there are still documents in the queue, restart the computer and try printing again after the 
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

To resolve print issues (macOS)

1. Check for error messages and resolve.

2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. In System Preferences, click Printers & Scanners .

b. Click the Open Print Queue button.

c. Click a print job to select it.

Use the following buttons to manage the print job:

● Delete: Cancel the selected print job.

● Hold: Pause the selected print job.

● Resume: Continue a paused print job.

● Pause Printer: Pause all print jobs in the print queue.

d. If you made any changes, try to print again.

4. Restart the computer.

Fix print quality issues

Step-by-step instructions for resolving most print quality issues. Troubleshoot print quality issues online

Read general instructions in the Help for resolving print quality issues

NOTE: To avoid print quality problems, always turn the printer off using the Power button, and wait until the 
Power button light goes out before you pull the plug or turn off a power strip. This allows the printer to move 
the printheads to a capped position, where they are protected from drying out.

To improve print quality, see Improve print quality on page 54.
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Copy issues
For more information, see Tips for successful scanning and copying on page 46.

Troubleshoot copy problems. Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer does not create a copy, or if your printouts are low quality.

NOTE: The HP online troubleshooting wizards may not be available in all languages.
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Scan issues
For more information, see Tips for successful scanning and copying on page 46.

HP Print and Scan 
Doctor

The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for the Windows operating system. 

Solve scan problems Use an HP online troubleshooting wizard.

Get step-by-step instructions if you cannot scan or if your scans are low quality.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards might not be available in all 
languages.
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Printer hardware issues
Close printer door

● Make sure the printhead access door and the front door are properly closed.

The printer shuts down unexpectedly

● Check the power and power connections.

● Make sure the printer's power cord is connected firmly to a functioning power outlet.

NOTE: When Auto-Off is enabled, the printer will automatically turn off after 2 hours of inactivity to help 
reduce energy use. For more information, see Auto-Off on page 19.

Resolve printer failure

● Turn the printer off, then on. If that does not resolve the problem, contact HP.
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Restore original factory defaults and settings
● If you have made changes to the printer, you can restore the printer to the original factory settings.

To restore printer factory defaults from the printer control panel

● While holding  (the Power button), press and hold  (the Black Copy button) and  (the Resume 

button) at the same time, until  (spinning wheel) appears on the display.
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Maintain the printer
● Clean the scanner glass

● Clean the exterior 

Clean the scanner glass

Dust or dirt on the scanner glass, scanner lid backing, or scanner frame can slow down performance, degrade 
the quality of scans, and affect the accuracy of special features such as fitting copies to a certain page size.

To clean the scanner glass

WARNING! Before cleaning the printer, turn the printer off by pressing  (the Power button), and unplug 

the power cord from the electrical socket.

1. Lift the scanner lid.

2. Clean the scanner glass and lid backing by using a soft, lint-free cloth that has been sprayed with a mild 
glass cleaner.

CAUTION: Use only glass cleaner to clean the scanner glass. Avoid cleaners that contain abrasives, 
acetone, benzene, and carbon tetrachloride, all of which can damage the scanner glass. Avoid isopropyl 
alcohol because it can leave streaks on the scanner glass.

CAUTION: Do not spray the glass cleaner directly on the scanner glass. If too much glass cleaner is 
applied, the cleaner could leak under the scanner glass and damage the scanner.

3. Close the scanner lid, and turn on the printer.
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Clean the exterior 

WARNING! Before cleaning the printer, turn the printer off by pressing the power button  (the Power 

button), and unplugging the power cord from the electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the 
interior of the printer, as well as from the printer control panel.
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HP support
For the latest product updates and support information, visit www.support.hp.com. HP online support 
provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation 
that came in the box with your printer.

HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view 
questions posted by other HP customers, or sign in and post your own questions and comments.

Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.

NOTE: You can also use the HP Smart app to check printer errors and get troubleshooting assistance. For 
information about this app, see Use the HP Smart app to print, scan, and troubleshoot on page 16. 

Contact HP

If you need help from an HP technical support representative to solve a problem, visit the Contact Support 
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted 
support for out-of warranty customers may require a fee):

Chat with an HP support agent online.

Call an HP support agent.

When contacting HP support, be prepared to provide the following information:

● Product name (located on the printer)

● Product number (located inside the front door)

● Serial number (located on the back or bottom of the printer)
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Register printer

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.

Additional warranty options

Extended service plans are available for the printer at additional costs. Go to www.support.hp.com , select 
your country/region and language, then explore the extended warranty options available for your printer.
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A Technical information

The information contained herein is subject to change without notice.

This section contains the following topics:

● Specifications

● Regulatory notices

● Environmental product stewardship program
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Specifications
For more information, visit www.support.hp.com .

System requirements

● For information about future operating system releases and support, visit www.support.hp.com .

Environmental specifications

● Recommended operating temperature range: 15℃ to 30℃ (59℉ to 86℉)

● Operating temperature range: 5°C to 40°C (41°F to 104°F)

● Recommended Operating Humidity range: 20% to 80% RH non-condensing

● Operating Humidity range: 15% to 80% RH non-condensing

● Nonoperating (Storage) temperature range: -40℃ to 60℃ (-40℉ to 140℉)

● In the presence of high electromagnetic fields, it is possible the output from the printer may be slightly 
distorted

● HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected 
noise due to potential high electromagnetic fields

Input tray capacity

● Plain paper sheets (75 g/m2 [20lb]): Up to 100

● Envelopes: Up to 10

● Index cards: Up to 30

● Photo paper sheets: Up to 30

Output tray capacity

● Plain paper sheets (75 g/m2 [20lb]): Up to 30

● Envelopes: Up to 10

● Index cards: Up to 30

● Photo paper sheets: Up to 30

Paper weights

● Plain Paper: 60 to 90 g/m² (16 to 24 lb)

● Envelopes: 75 to 90 g/m² (20 to 24 lb)

● Cards: Up to 200 g/m² (110-lb index maximum)

● Photo Paper: Up to 300 g/m² (80 lb)
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Print specifications

● Print speeds vary according to the complexity of the document

● Method: drop-on-demand thermal inkjet

● Language: PCL3 GUI

Copy specifications

● Resolution: up to 600 dpi

● Digital image processing

● Copy speeds vary according to the complexity of the document and model

Scan specifications

● Resolution: up to 1200 x 1200 ppi optical

For more information about ppi resolution, see the scanner software.

● Color: 24-bit color, 8-bit grayscale (256 levels of gray)

● Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution

● For supported print resolutions, visit www.support.hp.com.

Acoustic information

● If you have Internet access, you can access acoustic information from the HP website.
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Regulatory notices
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory model number

● Power cord instructions

● Visual display workplaces statement for Germany

● Noise emission statement for Germany

● European Union Regulatory Notice

● Declaration of conformity

Regulatory model number

For regulatory identification purposes, your product is assigned with a Regulatory Model Number. The 
regulatory model number should not be confused with the marketing names or product numbers.

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product. 
The product uses either 100-240 Vac or 200-240 Vac and 50/60 Hz.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the product.

Visual display workplaces statement for Germany

GS-Erklärung (Deutschland)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. 
Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im 
unmittelbaren Gesichtsfeld platziert werden.

Noise emission statement for Germany

Geräuschemission

LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

European Union Regulatory Notice

Products bearing the CE marking comply to applicable EU Directives and related European Harmonised 
Standards. The full Declaration of Conformity can be found at the following website:
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www.hp.eu/certificates (Search with the product model name or its Regulatory Model Number (RMN), which 
may be found on the regulatory label.)

The point of contact for regulatory matters is HP Deutschland GmbH, HQ-TRE, 71025, Boeblingen, Germany.

Declaration of conformity

Declaration of conformity can be found at www.hp.eu/certificates.
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Environmental product stewardship program
HP is committed to providing quality products in an environmentally sound manner. Design for recycling has 
been incorporated into this product. The number of materials has been kept to a minimum while ensuring 
proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and 
other connections are easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair.

For more information, visit HP's Commitment to the Environment Web site at:

www.hp.com/sustainableimpact.

● Eco-Tips

● European Union Commission Regulation 1275/2008

● Paper 

● Plastics

● Safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Disposal of waste equipment by users

● Waste disposal for Brazil

● Chemical substances

● The Table of Hazardous Substances/Elements and their Content (China)

● Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)

● Restriction of hazardous substance (India)

● Regulation on the Control of Waste Electrical and Electronic Equipment (Turkey)

● EPEAT

● SEPA Ecolabel User Information (China)

● China Energy Label for Printer, Fax and Copier

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. Please visit the HP Eco Solutions 
website for more information on HP’s environmental initiatives.

www.hp.com/sustainableimpact

European Union Commission Regulation 1275/2008

For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P15 
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‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper

This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Safety data sheets

Safety Data Sheets, product safety and environmental information are available at www.hp.com/go/ecodata 
or on request.

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products. For more information regarding recycling of HP products, 
please visit:

www.hp.com/recycle

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more 
information, go to the following website:

www.hp.com/recycle

Power consumption

HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Waste disposal for Brazil

Não descarte o produto eletronico em 
lixo comum

Este produto eletrônico e seus componentes não devem ser descartados no lixo comum, pois 
embora estejam em conformidade com padrões mundiais de restrição a substâncias nocivas, 
podem conter, ainda que em quantidades mínimas, substâncias impactantes ao meio 
ambiente. Ao final da vida útil deste produto, o usuário deverá entregá-lo à HP. A não 
observância dessa orientação sujeitará o infrator às sanções previstas em lei.

Após o uso, as pilhas e/ou baterias dos produtos HP deverão ser entregues ao 
estabelecimento comercial ou rede de assistência técnica autorizada pela HP.

Para maiores informações, inclusive sobre os pontos de recebimento, acesse:

www.hp.com.br/reciclar

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

The Table of Hazardous Substances/Elements and their Content (China)

产品中有害物质或元素的名称及含量

根据中国《电器电子产品有害物质限制使用管理办法》

部件名称

有害物质

铅

(Pb)

汞

(Hg)

镉

(Cd)

六价铬

(Cr(VI))

多溴联苯

(PBB)

多溴二苯醚

(PBDE)

外壳和托盘 ◯ ◯ ◯ ◯ ◯ ◯

电线 ◯ ◯ ◯ ◯ ◯ ◯

印刷电路板 X ◯ ◯ ◯ ◯ ◯

打印系统 X ◯ ◯ ◯ ◯ ◯

显示器 X ◯ ◯ ◯ ◯ ◯
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部件名称

有害物质

铅

(Pb)

汞

(Hg)

镉

(Cd)

六价铬

(Cr(VI))

多溴联苯

(PBB)

多溴二苯醚

(PBDE)

喷墨打印机墨盒 ◯ ◯ ◯ ◯ ◯ ◯

驱动光盘 X ◯ ◯ ◯ ◯ ◯

扫描仪 X ◯ ◯ ◯ ◯ ◯

网络配件 X ◯ ◯ ◯ ◯ ◯

电池板 X ◯ ◯ ◯ ◯ ◯

自动双面打印系统 ◯ ◯ ◯ ◯ ◯ ◯

外部电源 X ◯ ◯ ◯ ◯ ◯

本表格依据 SJ/T 11364 的规定编制。

◯：表示该有害物质在该部件所有均质材料中的含量均在 GB/T 26572 规定的限量要求以下。

X：表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T 26572 规定的限量要求。

此表中所有名称中含 “X” 的部件均符合欧盟 RoHS 立法。

注：环保使用期限的参考标识取决于产品正常工作的温度和湿度等条件。
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Declaration of the Presence Condition of the Restricted Substances Marking 
(Taiwan)

台灣 限用物質含有情況標示聲明書

Taiwan Declaration of the Presence Condition of the Restricted Substances Marking

單元

Unit

限用物質及其化學符號

Restricted substances and its chemical symbols

鉛

(Pb)

汞

(Hg)

鎘

(Cd)

六價鉻

(Cr+6)

多溴聯苯

(PBB)

多溴二苯醚

(PBDE)

列印引擎

Print engine
— ◯ ◯ ◯ ◯ ◯

外殼和紙匣

External casing and trays
◯ ◯ ◯ ◯ ◯ ◯

電源供應器

Power supply 
— ◯ ◯ ◯ ◯ ◯

電線

Cables
◯ ◯ ◯ ◯ ◯ ◯

印刷電路板

Print printed circuit board
— ◯ ◯ ◯ ◯ ◯

控制面板

Control panel
— ◯ ◯ ◯ ◯ ◯

墨水匣

Cartridge
◯ ◯ ◯ ◯ ◯ ◯

掃描器組件

Scanner assembly
— ◯ ◯ ◯ ◯ ◯

備考 1.〝超出 0.1 wt %〞及〝超出 0.01 wt %〞係指限用物質之百分比含量超出百分比含量基準值。

Note 1: “Exceeding 0.1 wt %” and “exceeding 0.01 wt %” indicate that the percentage content of the restricted substance exceeds the 
reference percentage value of presence condition.

備考 2.〝◯〞係指該項限用物質之百分比含量未超出百分比含量基準值。

Note 2: “◯” indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of 
presence.

備考 3.〝—〞係指該項限用物質為排除項目。

Note 3: “—” indicates that the restricted substance corresponds to the exemption.

若要存取產品的最新使用指南或手冊，請前往 www.support.hp.com。選取搜尋您的產品，然後依照 畫
面上的指示繼續執行。
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To access the latest user guides or manuals for your product, go to www.support.hp.com. Select Find your 
product, and then follow the onscreen instructions.

Restriction of hazardous substance (India)

This product, as well as its related consumables and spares, complies with the reduction in hazardous 
substances provisions of the "India E-waste (Management and Handling) Rule 2016." It does not contain lead, 
mercury, hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in 
concentrations exceeding 0.1 weight % and 0.01 weight % for cadmium, except for where allowed pursuant to 
the exemptions set in Schedule 2 of the Rule.

Regulation on the Control of Waste Electrical and Electronic Equipment (Turkey)

Türkiye Cumhuriyeti: AEEE Yönetmeliğine uygundur

EPEAT

Most HP products are designed to meet EPEAT. EPEAT is a comprehensive environmental rating that helps 
identify greener electronics equipment. For more information on EPEAT go to www.epeat.net. For information 
on HP's EPEAT registered products go to www.hp.com/hpinfo/globalcitizenship/environment/pdf/
epeat_printers.pdf.

SEPA Ecolabel User Information (China)

中国环境标识认证产品用户说明

噪声大于 63.0 dB(A) 的办公设备不宜放置于办公室内，请在独立的隔离区域使用。

如需长时间使用本产品或打印大量文件，请确保在通风良好的房间内使用。

如您需要确认本产品处于零能耗状态，请按下电源关闭按钮，并将插头从电源插座断开。

您可以使用再生纸，以减少资源耗费。

China Energy Label for Printer, Fax and Copier

复印机、打印机和传真机能源效率标识实施规则

依据“复印机、打印机和传真机能源效率标识实施规则”，该打印机具有中国能效标识。标识上显示的能
效等级和操作模式值根据“复印机、打印机和传真机能效限定值及能效等级”标准（“GB 21521”）来确定
和计算。

1. 能效等级

产品能效等级分 3 级，其中 1 级能效最高。能效限定值根据产品类型和打印速度由标准确定。能
效等级则根据基本功耗水平以及网络接口和内存等附加组件和功能的功率因子之和来计算。

2. 能效信息
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喷墨打印机

– 操作模式功率

睡眠状态的能耗按照 GB 21521 的标准来衡量和计算。该数据以瓦特 (W) 表示。

– 待机功率

待机状态是产品连接到电网电源上功率最低的状态。该状态可以延续无限长时间，且使用者
无法改变此状态下产品的功率。对于“成像设备”产品，“待机”状态通常相当于“关闭”状态，但
也可能相当于“准备”状态或者“睡眠”状态。该数据以瓦特 (W) 表示。

– 睡眠状态预设延迟时间

出厂前由制造商设置的时间决定了该产品在完成主功能后进入低耗模式（例如睡眠、自动关
机）的时间。该数据以分钟表示。

– 附加功能功率因子之和

网络接口和内存等附加功能的功率因子之和。该数据以瓦特 (W) 表示。

标识上显示的能耗数据是根据典型配置测量得出的数据，此类配置包含登记备案的打印机依据复印
机、打印机和传真机能源效率标识实施规则所选的所有配置。因此，该特定产品型号的实际能耗可能
与标识上显示的数据有所不同。

要了解规范的更多详情，请参考最新版的 GB 21521 标准。
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